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More Tips for
The Master Genealogist
by Beverly Levine Smallwood

and Anne Jacobs
Page 8-9

In The
Electronic
Section

August 17, 2002
Tips and Tricks to Stretch

Family Tree Maker
DAN NIEMIEC

Dan will show how to
make the most use of Family
Tree Maker to improve cus-
tom reports and to help or-
ganize your research. Even if
you’re not a FTM user, you
can apply these techniques to
the your software program.

July 20, 2002
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Publishing
A Web Page
By Anne Jacobs

Page 5

Finding Eastern
European Locations

By Anne Jacobs
Page 4

Our CAGG-NI President will demonstrate Bygones, a
Basic Genealogical Note-Keeping System to organize your
research notes and logs.

 ByGones is an electronic file cabinet where you can
record your successful research as well as your unsuc-
cessful research so you don’t have to do it again. It is
similar to CLOOZ except it is more flexible and it is a
free download.

This is the research exactly as you found it while en-
try into your lineage software is your interpretation of
that research.

September 21, 2002

Photo Retouching
ERIC BOND

Learn how to fix up those
old photos to make them look
like they were taken yester-
day.

Colonial Records of
Connecticut Go

Online
By Beverly Levine Smallwood

Page 2
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Colonial Records of Connecticut Go Online
by Beverly Levine
Smallwood

If you have colonial
Connecticut ancestors,
you are probably already
familiar with a 15 volume
set of books titled Con-
necticut (Colony). The
Public Records of the
Colony of Connecticut,
from April 1636 to Oc-
tober 1776 ... transcribed
and published, (in accor-
dance with a resolution of the General Assembly).  The
original source material is in the State Archives at the
Connecticut State Library.  The staff at the University
of Connecticut Libraries has digitized all 15 volumes
from a microfilm version and put it online at:

<http://www.colonialct.uconn.edu/>.

You may browse these books using an alphabetical
subject index, searching by date, or by selecting a vol-
ume and page number.  It then displays a jpeg image of
the page requested.  You may click on "Next" or "Previ-
ous" to flip through the pages of the book to flesh out
the context of the entry as necessary.  If you want to
save a copy of the page, click on the link to download a
300 dpi TIFF image to your computer.

Because it is an image, or picture, of the page, you
can not do a ctrl+F text search to find the occurrence of
your ancestor's name on the page.  This is not a great
impediment to most genealogical researchers, though
historians might find it a problem as not every keyword
they might find interesting has been indexed.  The website
notes: "Although full-text and keyword access to the
text is not yet available, future phases of the project will
most certainly incorporate this level of advanced access."
My only complaint would be that there is no provision
to search the indexes of all the volumes at once.

I would suggest starting with the alphabetical index
and looking not only under the surnames of interest, but
also the towns they lived in.  Your ancestor might not be
named, but a look under the towns may shed some light
on what the hot topics of conversation were at the time.

In these pages you'll find lawsuits and divorce, service
in public office, military appointments and actions, lay-
ing out of land and surveying of roads, settlements, pur-
chases, and loans.  Sometimes a person's death is a foot-
note to his successor's appointment.  If you have Con-
necticut ancestors, you will want explore this site thor-
oughly.

Dick Eastman reviewed this site in his weekly news-
letter on June 26th.  For those of you who may have
missed it, go to <http://www.ancestry.com/library/
view/columns/eastman/5969.asp> for his com-
plete review.  You might also want to consider subscrib-
ing to his online newsletter.  I always look forward to its
arrival in my in-box.

The Newsletter Editor
will be on vacation
in August so . . .

Friday, July 26th

http://www.colonialct.uconn.edu/
http://www.ancestry.com/library/view/columns/eastman/5969.asp
http://www.ancestry.com/library/view/columns/eastman/5969.asp
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President’s Letter

Beverly Levine SmallwoodBeverly Levine SmallwoodBeverly Levine SmallwoodBeverly Levine SmallwoodBeverly Levine Smallwood

I hope everyone had a safe and happy 4th of July.  Look-
ing back at last month's program, I think Virginia did a fine
job demystifying html.  Some of you may have been thinking,
"Well, I don't really need to know that.  My genealogy pro-
gram will create all my web pages for me."  Yes… and no.
You see, whether you create html pages using a genealogy
program or a word processor, you just might find the need to
do a bit of tweaking to get it looking the way you want.  Re-
member how Virginia clicked on "view source" to see the html
behind the web page?  If you see a great web site and you
wonder how it was done, you can view the source to learn
new techniques.

We also passed out Shop and Share coupons at the last
meeting.  Our second set of dates was July 1st through 3rd.  I
hope you all stocked up on the staples and bought a huge
watermelon for your 4th of July picnic.  I hope you remem-
bered to hand out these coupons to your family, friends, and
neighbors as well.  This is one idea we came up with to raise
funds without raising dues so we can do more for you.  It
doesn't cost you anything extra to turn in that coupon at check-
out.  (Though I did have to tell a new cashier what it was and
what she needed to do.)

I just got a check from Jewel Food Stores for our first
Shop and Share effort.  It seems that thirty-one of you went
shopping at Jewel June 3rd through the 5th and spent a total
of $2,140.28.  Jewel sent Cagg-ni a check for $107.01.  I was
hoping we could get at least 50 people to do their shopping on
one of those three days, but it's a start.  Our third and final set
of Jewel Shop and Share days for 2002 will be September 9th
through the 11th.

You may be asking yourself just why we need to raise
funds.  There are a couple of reasons for building a nest egg.
Firstly, we have had some large turn-outs at some meetings
this year, which is a good thing.  There is no reason Cagg-ni
couldn't or shouldn't be four times larger than it is at present.
More members = more knowledge and experience to share
with one another.  Growth would also bring growing pains.
The projector we use is fixed in a room of particular dimen-
sions.  If we out-grow the room, we would need to find an-
other projector.  Secondly, we've been discussing putting on
or co-sponsoring a workshop.  There are up-front costs at-
tached to doing something like this and many societies like to
have all expected costs in the treasury before embarking on
the adventure.  Successful workshops are not only great fund
raisers in themselves, but they are also a great way of getting
new members.  If you have any ideas about or experience
with workshops, please contact me.  I'd also be eager to hear
about any other fundraising ideas you may have.

This month's program is a demonstration of the Bygones
Note-taking software.  The program's author, Troy Adair,
was kind enough to donate some CDs with the program and

slide-show tutorials.  These will be available at our meeting
for purchase as another small fundraiser for Cagg-ni.  If you
have a slow modem or being online means tying up your phone
line, consider the advantages of a CD.  I hope to see you all at
the meeting.  If you have never seen Bygones, you'll see why
I'm a believer.  If you've downloaded it, but still haven't got-
ten around to using it, I hope to get you started.  If you are an
enthusiastic Bygones user, I hope you'll join us and share
your experiences.  You see, Bygones is such a flexible and
versatile program that every user might use it just a little dif-
ferently.

See you soon.

mailto:Caggni_Bev@yahoo.com
mailto:PatJW28@interaccess.com
mailto:CDouglas1@ameritech.net
mailto:RESommer@aol.com
mailto:mebreslin98@Yahoo.com
mailto:JimboDeuce@Yahoo.com
mailto:ROPulse@aol.com
mailto:Ancestorseeker@attbi.com
mailto:PatJW28@interaccess.com
mailto:Caggni_Bev@yahoo.com
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Finding Eastern European Locations
Even if you don’t have Jewish genealogy research,

there is a great tool available on the JewishGen site:
http://www.jewishgen.org  Pat Weisshaus first
pointed this feature out to me.  I have found it very use-
ful even though I am not doing Jewish genealogy.

One of my problems with German genealogy is with
locations.  I am not familiar with Germany as I am with
the United States.  So any tool which I can find to help
me with this problem in my research is welcome.

One such tool I have found helpful is on the
JewishGen site called “ShtetlSeeker”.  A Shtetl is a “vil-
lage”, so this is a tool to find villages in Eastern Europe.
Using this tool you can find all possible villages/settle-
ments/cities with a certain name or similar name.  After
you have found the village then you can use another
feature at this site to find all villages within a given dis-
tance of the target village.  This is helpful as it gives you
an idea of what is reachable from your ancestor’s home
town.  One of the maps which Chris Kite presented in
his Maps program earlier this year was one which showed
how far you could travel from New York City in a day
over the years (1810, 1850, 1900, etc.).  It is important
to know what villages are within a day’s travel of your
ancestral home; this should define the area of your re-
search.

The Shtetl Seeker is found on the site listed under
the main heading Research, subheading JewishGen Da-
tabases as a link to another page.  This screen explains
the purpose of the site and some limitations.  At the
bottom of the page is the Shtetl functions links.  Start by
clicking on the link “towns”.  This will bring up a “form”
page which allows you to enter a town name and select
a specific country. Type the name of a village of interest
in the form slot and hit enter.  I am interested in Bitburg
so that is what I will use.  Click on the button “Start the
search”.

The results are displayed in a table containing the
Town name, Coordinates, Name Type, Country and Dis-
tance/Direction from reference point.  There are 42
matches displayed.  Many of them seem to be “way off
base”.  However, that seemed to also be the case the
first time I saw the results of the SOUNDEX search for
one of my names.  This site uses a different
SOUNDEXing method called Daitch-Mokotoff which
works better for Slavic and Yiddish names, pulling more
divergent spellings together.  An explanation of this
method is found on the same site under the main page

link InfoFiles.  I have found this list interesting as it pre-
sents many possibilities which I was unaware of such as
Betberg and Bedberg.  Frequently I have assumed that
other researchers have misspelled a name and this list
shows that there are other names very similar to the one
I believe to be correct.

Find the most correct location in the presented list
and copy down its coordinates for later use in the other
neat feature of this site.  If you are not sure of the cor-
rect town, by clicking on the coordinates, you are taken
to a Mapquest map of the town which gives you an idea
of the general location.  (Hint:  If you hold down your
right mouse button and select “Open a new window”
from the pop-up menu which appears, you will save your
screen position on the Shtetl page.  I find this useful in
many of my searches as it maintains the original page
position without hitting the “Back key”.)   After you are
satisfied that this is the correct town, return to the Jew-
ish site by hitting the back menu selection or just close
the window, depending on how you got to this screen.

Now you are ready to find all the towns close to
your ancestor’s home town.  Click on the word (link)
“distance” in the last paragraph of the page.  A new
form page is presented into which you can key the coor-
dinates you copied earlier.  Up to 2 digits fit in each one
of the slots.  Bitburg’s coordinates are 4958 632 so I
key in 49 in the first slot, 58 in the second and 6 in the
third and 32 in the last.  (If you question how to split the
numbers into Latitute and Longitude, look at a map of
the area to determine what combination makes sense
for the area.)  I may select from 1 to 30 miles or kilome-
ters using the form field just above the coordinates fields.
Also, I can limit my search to only those villages begin-
ning with a certain letter by keying it in the last form
field on the page.  After making all my selections (10
miles, 49 58 6 32 and nothing in the beginning letter
slot), I click on the “Start the search” button.  171 Shtetls
are returned in a table similar to the first table returned.
However, this time the last column gives the number of
miles from the target location.  I have found many of the
other villages in my genealogy listed in this table.  If you
know which town has the church in it, you can see how
far they had to go.  It is interesting to note how far my
people had to travel to each place.  This also gives you a
list of towns you can take to the FamilySearch site to
see what films the LDS Church has on these villages.

By Anne Jacobs

http://www.jewishgen.org
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Chicagoland Family
History Centers

Hyde Park FHC News
(Chicago, Cook County)

5200 South University Avenue
1-773-493-1830

Sun 9:00am-11:00pm and 1:00pm-6:00pm
Wed. 6:30-9:00pm, Friday 5:30-9:00pm,

Sat. 9:00am-4:00pm
Closed Monday, Tuesday and Thursday, Holidays,

1st weekend of April and October
Hyde Park has changed its hours making it easier to research

your family.

July Puzzler:
What determines the scope of the search when you

use “Find” in a word processor or a browser (Netscape)?

July Puzzler Answer:

Family Story Question of the
Month:

What has been a long standing family incident/story
regarding politics.

Tag Line:
Always remember you are unique, just like every-

one else.

Publishing a Web Page
By Anne Jacobs

Virginia Jenkins presentation brought quite a few com-
pliments on how well the material was delivered and that “she
really knows her stuff”.  She gave the three steps to a per-
sonal web site as: Plan, Code, and Publish. I have received a
few inquiries about the last step since the presentation, so I
thought I would try to explain further.

In order to publish your website, you have to upload each
page (file) to a unique place on the web.  Every website page
has a unique address.  CAGG-NI’s address, http://
www.rootsweb.com/~ilcaggni is at RootsWeb.  The first
part of this address is RootsWeb, and the "~ilcaggni" is our
little corner of the RootsWeb site.  Think of it as our file
cabinet.  Unless you register and pay for your own domain
name, your website will have a unique file folder name at the
end of someone else's address as well.

Every ISP (Internet Service Provider) that I know of will
provide you with a standard amount of space to establish a
website.  The first portion of your website’s address is likely
to be the same as your ISP’s home page.  The last portion will
be your unique “folder” at this address.  Many ISPs use your
e-mail address as the name of your unique folder.  If I were to
establish a home page at attbi.com it would be http://
www.attbi.com/ancestorseeker with ancestorseeker be-
ing my own unique identification, my e-mail account, (called
a screen name by AOL).  To find what your address would be
visit your ISP's home page and look for the instructions on
establishing your web page.  Part of the directions at your
ISP will tell you what your unique folder name is.  (Not to
muddy the waters, but there are also other websites which
offer free space, such as MyFamily.com and Yahoo.com.
Some are private and you invite “members” who can view the
site and others are open to the entire Internet audience.)

Once you have your website address, you know where to
publish the files(html, jpg, etc.) which will comprise your
site.  You publish your website by uploading each file to this
address.  Each page must have its own unique name.  The
software you use depends on your ISP or browser.  The pro-
cess is called FTPing (File Transfer Protocol) the files(s) to
this folder.  When I established the CAGG-NI site, I used
Netscape Composer which has a Publish function listed in
the File dropdown menu.  Once you start this process, you
will be able to identify the file to upload by supplying its full
address (the source) as well as the address to send the file to
(the target).

This is as specific as I can get because the exact steps are
dictated by the software you use and the site to which you
upload your web pages.  If you have problems, send a mes-
sage to the CAGG-NI e-mail account and help will arrive
soon.

The entire document/page is searched until you have
found something.  Nothing in the “document” is high-
lighted at the beginning; after a find, the “found” text is
highlighted.  I have found that at times, only the high-
lighted text is searched.  If I do subsequent searches,
sometimes nothing is found which I have learned to ques-
tion.  If this happens to you, change the search to some-
thing you know is there, like “the” without the quotes.
If it is not found, you know that the search is not work-
ing like you expect it to be.  Make sure that nothing is
highlighted and try the search again.  I don’t know why
this happens sometimes but clearing the highlighting
corrects the fluke.

http://www.rootsweb.com/~ilcaggni
http://www.rootsweb.com/~ilcaggni
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Other Group Events Compiled by Beverly Levine Smallwood

31 JUL 2002 - NAPERVILLE FHC
Preserving Our Family Photo Heritage

BY JANET SOLIS
To register for this class: email

deanna@spingola.com or call the FHC at 505-0233

04-09 AUG 2002 - TORONTO

IAJGS International Conference
on Jewish Genealogy

http://www.jgstoronto.ca/Conferences2.html

07-10 AUG 2002
The Federation of Genealogical Societies
(FGS) at the Ontario Convention Center,

in Ontario, California
http://www.fgs.org/2002conf/FGS-2002.htm

08 AUG 2002 - 6:30 PM
Dead Men Do Tell Tales:

On-Site Cemetery Research in Marengo
McHenry County Genealogical Society

http://www.mcigs.org/MeetingNew.htm

10 AUG 2002 - 10:30AM

TMG (The Master Genealogist)
User Group Meeting

Schaumburg District Library, 130 S. Roselle Road
http://www.rootsweb.com/~ilcaggni/

13 AUG 2002 - 7PM
Fremont Library in Mundelein

Lake County Probate Research - Debbie
Mieszala

Lake County Genealogical Society
http://www.rootsweb.com/~illcgs/meetings.htm

13 AUG 2002 - 7:30 PM
Records in the Roman Catholic Archdiocese

of Chicago - Julie Satzik
Schaumburg Township District Library

Genealogy Group

15 AUG 2002 - 7PM
Gail Borden Public Library

KATHRYN BARRETT

Are You Ready for 1930?
Elgin Genealogical Society

http://www.elginarea.org/egs/page3.html

19 AUG 2002 - 7PM

What is in a name, the History of Lake
County - Diane Dretzky
Zion Genealogical Society

http://nsn.nslsilus.org/wkkhome/zion/index.html
Beach Park Village Hall

11270 Wadsworth Rd, Beach Park

25 AUG 2002 - 2PM NORTHBROOK PUBLIC LIBRARY
MARTIN TOUHY

The 1930 Census and Related Sources
North Suburban Genealogical Society &

Jewish Genealogical Society
http://www.wpld.alibrary.com/nsgs.htm

21 SEP 2002 - ALL DAY
(early registration deadline is August 17th)

British Isles Research
Over Here/Over There

BIGWILL & McHenry County Genealogical Society
at McHenry County College

http://www.rootsweb.com/~wiilbig/meet.htm

28 SEPT 2002 - 8AM-4PM
Fox Valley Genealogical Society Fall Conference

Unlocking Ancestral Mysteries
WITH HENRY Z "HANK" JONES

http://members.aol.com/fvgs1/index.html/
Grace United Methodist Church
300 E. Gartner Road, Naperville

03-05 OCT 2002
Iowa Genealogical Society Annual Conference,

Marshalltown, Iowa
Your Elusive Ancestor

BY SHARON DEBARTOLO CARMACK
http://www.iowagenealogy.org/Conference/2002Fall/

fall_main.htm

04-06 OCT 2002
Polish Genealogical Society

2002 Conference - Basics & Beyond
Ramada Inn, 6600 N. Mannheim Rd., Rosemont

12 OCT 2002 - ALL DAY - WAUSAU, WI
Wisconsin State Genealogical Society

Fall Conference
FEATURING HENRY "HANK" Z. JONES, JR., FASG

http://www.rootsweb.com/~wsgs/meetings.htm

http://www.jgstoronto.ca/Conferences2.html
http://www.fgs.org/2002conf/FGS-2002.htm
http://www.mcigs.org/MeetingNew.htm
http://www.rootsweb.com/~ilcaggni
http://www.rootsweb.com/~illcgs/meetings.htm
http://www.elginarea.org/egs/page3.html
http://nsn.nslsilus.org/wkkhome/zion/index.html
http://www.wpld.alibrary.com/nsgs.htm
http://www.rootsweb.com/~wiilbig/meet.htm
http://members.aol.com/fvgs1/index.html/
http://www.iowagenealogy.org/Conference/2002Fall/fall_main.htm
http://www.iowagenealogy.org/Conference/2002Fall/fall_main.htm
http://www.rootsweb.com/~wsgs/meetings.htm
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June Meeting Notes
By Anne Jacobs

Creating a Web Page
Virginia Jenkins gave her presentation on HTML

codes to create web pages.  She had already made the
presentation to the TMG group and it was such a hit
that she was asked back for an encore to the main group.
Virginia started her talk by discussing the steps to creat-
ing a web site.  First, decide what content you want to
have on your website.  After you have this focus, plan
the site, using a paper and pencil.  Sketch out its content
and structure, breaking it into bite sized pieces because
people dislike too much scrolling and smaller pages will
load quicker.  Next “code” the pages and lastly, publish
your website (see my article on publishing elsewhere in
this newsletter).

Although this seems to be an intimidating subject,
once you see what is involved, it becomes easy to un-
derstand.  All web pages are simple text documents.  This
is why the message at the bottom of your browser screen
says “downloading document” when it is accessing a
web page.  Simple web sites are created using a specific
format called HTML (Hyper Text Markup Language).
It has its roots in newspaper markup language which
printers would use to indicate special format instruc-
tions.  More complex sites use java, applets, frames and
cascading style sheets.  These are mentioned only to let
you know that they exist but you don’t need them.  Your
website can be quite uncomplicated.  Once you have
your confidence up after creating your first site, you can
delve into these more sophisticated tools.

The basic format of most HTML codes is a begin-
ning code and an ending code.  These are almost identi-
cal except that the ending code contains a slash (/).
Contained within the opening code boundaries may be
attributes, these are not required.  Most codes are
bounded by less than (<) and greater than (>) symbols.
So most HTML code pairs look like this:

<code attribute=”myattribute>  </code>
Virginia presented the basic codes used in web site

organizing them into categories:
· Basic tags in HTML documents
· Tags which define structure
· Text effects and color tags including special char-

acters
· Adding graphics
· Links and anchors

Virginia organized her material by creating web page
elements which stated what was being demonstrated
using the HTML code which created that effect.  So she
would have “This is bold text” surrounded by the HTML
codes which causes the text to be displayed as bold.  So
this would be: <B>This is bold text.</B>

Naturally, there are some exceptions to the rules.
Some HTML codes are composed of an opening code
without a closing code such as a “next line” code which
is <BR> without an </BR> which makes sense if you
think about it.  A handout at the meeting contained all
the codes you need to create a page.

One suggestion she made was to look at “what makes
a web page tick” next time you see a page which im-
presses you.  You do this by selecting the “View Source”
selection from the View menu (Netscape) and “Source”
selection from the View menu (Internet Explorer).  Fo-
cus in on one area of page rather than trying to learn the
entire page.  Look for the English which is displayed on
the screen and examine the HTML tags which are asso-
ciated with this portion of the page remembering that
<code> begins the structure and </code> ends the struc-
ture.  Virginia has a website which is the outline she
used for the presentation including supporting docu-
ments.   Its address is http://homepage.interaccess.com/
~vjenkins/outline.htm   Try this with her pages.

Most genealogy programs today generate HTML to
display your data on the Internet. However, frequently,
this generated code does not meet your standards.  With
what was presented at this meeting, you can tweak this
generated code to improve the appearance of your site
and make it yours.

Virginia recommended a number of books for fur-
ther study and as reference books.  These were:

Scharf, Dean.  HTML 3.2 Visual Quick Reference,
Que Books, 1997.

Maran, Ruth.   Teach Yourself HTML Visually. &
Creating Web Pages with HTML.  IDG Books
Worldwide. 1999

Niederst, Jennifer.  Web Design in a Nutshell: A
Desktop Quick Reference.  O’Reilly Books, 1999

Wilson, Richard S.  Publishing Your Family History
on the Internet.  Compuology, 1999.
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The Master Genealogist Tips
Creating Your Own Shortcuts

Is there something you do all the time?  Why not
create a custom toolbar button?  A time saver is always
desirable whether it is something you need all the time
or just for now.  Here is how to do it and some sugges-
tions of buttons I've found useful.

To add a custom button, go to Tools  Options (or
CTRL+O) and click on the Toolbar tab (in version 5
you simply right click on the toolbar and select Custom-
ize).  The box on the left has all the buttons on your
toolbar.  The top item is the button on the far left; the
bottom item is the button on the far right.  The box on
the right contains other items that can be added.  Func-
tions are arranged according to where they appear on
the dropdown menus but some of the most interesting
are all the way at the bottom.  Select a useful function,
like "Search for Siblings" and click on Add.  Click in the
left-hand box and go to the bottom; click on "Search for
Siblings" then click on Properties.  If you have a bitmap
or icon to apply to the button, you may apply it here,
otherwise leave it on Text and input something brief and
informative like "Sibs" (without the quotes).

Anything you type next to ToolTip Message will be
displayed in a pop up bubble when you hover your mouse
over the button.  Click OK and OK again to go back to
TMG.  You will now see a button labeled Sibs.  When-
ever you click on it, you will either be moved to the

person's brother or sister, or be presented with a list of
siblings if there are more than one.  I've found this but-
ton useful in data entry, particularly with census and other
"whole family" type records.

I go to the Master Source List quite often so, rather
than selecting Tools  Master Source List each time, I
created a button that would open it with a single click.
Creation of the button is just like adding "Sibs".

If you played with the Relative Auto-tag from last
month's article, you might want to create a custom but-
ton to toggle it on and off.  Create the button just like
the "Sibs" button above.  You'll find it near the bottom
of the right hand box.  One click will turn the feature
off; another click turns it back on.  Unfortunately, you
will have to go through the steps outlined last month to
change the target individual.

I've been doing a lot of the 1930 census lately so I
added a button to add a census tag rather than opening
the tag box and dropping down to select census.  To do
this, select "Add a tag of a specific type", which can be
found near the bottom of the list.  This button requires
an additional parameter so when you add it to the left, a
window pops up to warn you of this.  You will see an
extra spot at the bottom of the properties dialog box for
the tag label.  Make sure you type it in exactly - caps,
lower case and all.  Now a single click opens a census
tag for data entry.  When I've finished with the census
and start working on a will book or land records, I can
change the properties for this button to that tag type.

A good way to preview the sentence
structure and narrative flow as you
are doing data entry is to create a re-
port to preview it a little bit at a time.

Since you will be looking at this report on a fre-
quent basis, you'll want to attach it to a toolbar button.

Let's start with report creation.
As with everything else, there is more than one way

to do this.  You can go to Report  Descendants 

by Beverly Levine Smallwood

Continued on next page
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Keyboard Template
for TMG Users

Well, TMG 5.0 has been released.  Some TMG us-
ers around the country have developed templates which
can be downloaded to help you get used to the new hot
key assignments.  Here are a few sites to check for these
downloads:

The Roots Users Group of Arlington, Va. Site http:/
/www.rootsusers.org has a PDF format requiring Adobe
Acrobat and an zip version.  Links to the un-zip soft-
ware are provided.

Rusty Wright created his own Adobe version at:
http: / / eructate .berke ley.edu/ tmg/ tmg-

quickref.html
or
http://www.tmgtips.com/TMG-QuickRef.zip

Tracking Life Span
Using TMG
By Anne Jacobs

In reading this piece, please note that both Tags and
Flags are discussed.  There is both a Living Tag and a
Living Flag in TMG.  Which one is being addressed
makes a difference in understanding my technique.

I have been collecting obits lately.  Obituaries fre-
quently have a list of surviving family members.  It oc-
curred to me that this information might be useful in
narrowing down the survivors’ death date.  I was add-
ing a Death Tag for each survivor and recording that
they died, or would die, sometime after the date of their
relative’s obit. The problem with this method is that the
“Living Flag” is changed to “N” when a Death Tag is
entered for a person, and they might still be living.

This caused me to change my method.  I discovered
a tag called Living.  (I believe this is a standard tag, in
other words, one established in the base TMG pack-
age).  I now use the Living Tag to record that they were
last known to be living on a particular date.  If I later
obtain another obit, or any other data, with a later date,
I just change the established date to the new one.  In this
way, I can keep “living” people as living which prevents
their details from being copied to a GEDCOM when I
select the “Suppress details for living people” option.

Journal (Narrative)  (design another) but I would sug-
gest you go to Report  Custom Report Writer and
click on New, then select Genealogy Format from the
list.  Give it a name and be sure you note what it is

exactly - upper case, lower case, spaces and all.  This
will be important when we create the button.  On the
General Tab, make sure output is to the screen, then
click on Publication Tools and make sure Memos,
Sources, and Exhibits are all set to "none" since the re-
port is not meant to be printed and published.  Leave the
Focus Tab set to "Prompt When Generated" and click
on the Type Tab to choose a style (Register, Record,
TAG, or custom) and limit it to one generation.  Make
any additional choices on the Tags and Misc. Tabs, then
click Generate to verify that the parameters you've set
give the desired results.

Now that the report has been created, let's add it to
a button.  Type CTRL+O and click on the Toolbar tab.
Look for "Execute a report by configuration name" un-
der Special Functions in the right-hand box and add it to
the toolbar box on the left.  A warning box will tell you
to modify the parameters.  Locate and select it in the
left-hand box, then click on Properties.  In addition to
naming the button and modifying the ToolTip message,
put the report name in at the bottom exactly as it was
named - case, spaces, and all.  Now a single click will
bring up this report so you can preview your results
onscreen as you go along, rather than engaging in a major
editing job when you are ready to publish.

What buttons will you create?

TMG Tips (Continued)

http://www.rootsusers.org
http://www.rootsusers.org
http://eructate.berkeley.edu/tmg/tmg-quickref.html
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http://www.tmgtips.com/TMG-QuickRef.zip
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